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1INTRODUCTION TO WORD 
Writing a Conference Call letter 

BEFORE YOU BEGIN 
Lesson 1 makes the assumption that you are already familiar with the Windows computing 
environment, though you may not be an expert in its use.  If you are using a computer in a 
lab at school, you'll also know: 

 where to find the computer lab on campus; 
 how to turn the computer on; 
 how to log on to the system (using your login name and password). 

You also should be familiar with the Windows, Icons, Menus, and Pointers (the so-called 
WIMP interface) with which you interact with the computer.  If not, your instructor will 
make this clear to you before you proceed with these tutorials. 

Lesson 1 assumes that you have a copy of the set of work files that accompany these 
tutorials.   These files should be stored on your hard drive and/or on a USB Flash drive.  
Whatever type of disk drive you are using, be sure it is labeled (named) appropriately. 

The work files that accompany these tutorials should be stored on the drive in three 
folders named Work Files, PowerPoint Files, and Access Files.  You also will need a fourth 
folder for the data files that you will be creating while working your way through the 
tutorials.  This fourth folder will be called Data Files. 

Ideally, you should have a second backup copy of the four folders mentioned above 
(Work Files, PowerPoint Files, Access Files, and Data Files). 

If you do not have these folders and files ready, prepare them now before proceeding 
with this tutorial.  Here are the steps to take: 

If necessary (if you received a zipped copy of the work files with these 
tutorials), unzip the set of Work Files for Office 2013 (your instructor will help 
you with this if you are working with a class) 
Copy onto your disk (USB drive and/or hard drive) the folder titled Work Files 
for Office 2013, which includes the three sets of files that accompany these 
tutorials (Work Files, PowerPoint Files, Access Files) 
Double click on the Work Files for Office 2013 folder to open it, and, inside 
the Work Files for Office 2013 folder, create a new, fourth, folder called Data 
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Files (one way to do this is to click on the Organize menu of the Work Files for 
Office 2013 folder, select New Folder from the drop-down menu, and, in the 
sub-menu, select Folder.  The system will create a new folder for you and then 
wait for you to give it a name of your choice.  Call it Data Files.) 

 
A caveat (warning) before you begin: You'll find it easiest to use this tutorial if you follow 
the directions carefully.  On computers there are always other ways of doing things, but if 
you wander off on your own be sure you know your way back! 

 
LEARNING OUTCOMES 
Words are crucial tools of a teacher's trade.  As a teacher, you owe it to yourself and to your 
students to use words well.  The Office 2013 word processor will help you improve your 
writing skills because it makes revision easy and thus encourages you—and your students—
to correct errors in grammar, spelling, and style. 

In this tutorial, along with some helpful hints to bear in mind when word processing, 
you will learn the steps required to produce a word processed document from scratch and 
carry out basic formatting and editing functions.  These include: 

 opening and naming a new word processor document 

 entering and saving a document 

 updating and simple formatting of a document 

 checking a document for spelling and grammar errors 

 printing a document 

 making a backup copy of a document 
It is likely you are not a beginner to word processing, so you may think you don't need to 
complete this tutorial.  That would be a mistake.  Most computer users learn no more than 
the minimum they think they need to know to use a program such as Word, without taking 
the trouble to learn other useful features of the software.  In other words, even if you have 
used a word processor for a while, there's a good chance that you will still benefit from 
completing this beginner's tutorial. 

So, with this in mind, please conscientiously work your way through the tutorial with a 
view to learning new things.  You'll be surprised what you’ll discover! 

 
1.1 OVERVIEW OF MICROSOFT OFFICE 2013 
If you come to Office 2013 after having previously used Office 2007, you will be happy to 
know that the Office Button (introduced in Microsoft’s Office 2007) is thankfully gone.  It 
has been replaced by the restored and more familiar File menu, which, as introduced in 
Office 2010, gives the user a Backstage view on the document or file that the user is 
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developing.  In the Backstage view, you do things TO a file (such as save it or open it or 
print it) that you do not do IN the file (such as any kind of editing of the document).  The 
Backstage View as it appears in Office 2013 takes some getting used to, but by the time you 
are done with these tutorials you will be using it like a pro. 

Also, prior to Office 2007, users were familiar with a traditional, and by then kind of 
old-fashioned system of menus, toolbars, task panes, and dialog boxes to get their work 
done.  In Office 2013 you will continue to use menus and dialog boxes; but, as introduced 
with Office 2007, Office 2013 also uses what Microsoft calls Ribbons, which have greatly 
simplified navigation of the many cool features of the Office word processor.  If you are 
already familiar with either Office 2007 or Office 2010, feel free to skip the rest of this 
section and proceed directly to Section 1.2 OPENING AND NAMING A NEW WORD 
PROCESSOR DOCUMENT. 

A Ribbon is a strip that runs across the top of a window which presents word processing 
options organized into a set of Tabs (Fig. 1.1).  For each Tab there is a different Ribbon, 
such as the Home Ribbon illustrated in Fig. 1.1, in which you will find Groups of options. 

 

 

 
 
 

Fig. 1.1 The features of the Office 2013 User Interface 
Ribbons have Tabs; each Tab contains Groups of word processing tools that are closely 
related from the point of view of functionality.  For example, in the Home Ribbon (see 
Figure 1.1 above) you will find the most basic, and therefore the most frequently used word 
processing functions.  The Groups in the Home Ribbon also include the tools you would 
tend to use when you first open a Word document and need to set it up with fonts and style 
and spacing and so forth before proceeding to add text. 

These Home Ribbon Groups include the Font Group, which has all the tools you need 
that deal with fonts and text sizes and styles and colors and so forth.  Then in the Paragraph 
Group are all the tools for line spacing, text alignment, bullets and numbering, indentation, 
and borders.  Next is the Styles Group if you want to use a predefined style layout for your 
document.  Finally in the Home Ribbon you have the Editing Group, which has tools that 
you would be likely to use on an ad hoc basis while developing a document.  Also, notice 
the Clipboard Group over to the left of the Home Ribbon, very useful when you are cutting 
and pasting text within a document or from one document to another. 

Many of the tools in the various Office Ribbons can still be accessed using a key 
sequence at the keyboard.  Later in these lessons you will be introduced to many of these 

The Home Tab, which lets you use the tools in the Home Ribbon 

The File menu 
Paragraph, Styles, and 

Editing Groups 

The Font Group in 
the Home Ribbon 
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so-called Quick Keyboard Commands.  For this reason, the author has prepared a chart that 
breaks down the most used Office Word 2013 quick keyboard commands.  The chart is 
available as a separate download at the end of the list of contents on the download site for 
these Office 2013 tutorials. 
 
1.2 OPENING AND NAMING A NEW WORD DOCUMENT 
Before you can use Microsoft Word 2013, you must first open the program.  If this is your 
first time using Word for Windows1, here is what you need to do: 

Click on the Start button in the lower left corner of the screen, then, from 
the All Programs menu, locate (scroll to find) the Microsoft Office 
submenu, then in the sub menu select Microsoft Office Word 2013 

If you can find Microsoft Word by yourself, open the program now; 
otherwise get help from a friend, or your instructor, or from the lab 
supervisor 

After you have opened Word, you will be presented with the following Office 2013 
Backstage window on your computer (Fig. 1.2). 

 
Fig. 1.2 Initial Word Backstage View 

                                                
1 For the purposes of this book, all illustrations are created using Microsoft Windows 7 running Office 2013  
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As you can see, you have the option to open a Blank Document (a new document), or you 
can open any one of several word processing templates.  Templates are useful because 
they save you having to create professional-looking documents, such as gift certificates 
and so on.  But for our purpose here, you want a new blank document open on your 
screen. 

Click once on Blank document (Fig. 1.2 above) 
You should see a blank word processor document on your screen.  If you are already familiar 
with either Office 2007 or Office 2010, feel free to skip to page 10. 

Now take a moment to take a look at each of the Ribbons for Office Word 
2013—starting with the Groups of the HOME Ribbon (Fig. 1.1 on 
previous page). 
Next click on the tab for the INSERT Ribbon and check out the various 
Groups of tools available (Fig. 1.4) 

 
Fig. 1.4 The Groups in the INSERT Ribbon 

At this stage do not worry about all the details; the features of Word can be overwhelming 
at first.  Spend a couple of minutes clicking on each of the Group names and scanning the 
many options available to you. 

Click on the tab for the DESIGN Ribbon and check out the various 
Groups of tools available (Fig. 1.5) 

 
Fig. 1.5 The Groups in the DESIGN Ribbon 

Click on the tab for the PAGE LAYOUT Ribbon and check out the 
various Groups of tools available (Fig. 1.6) 

 
Fig. 1.6 The Groups in the PAGE LAYOUT Ribbon 
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Click on the tab for the REFERENCES Ribbon and check out the various 
Groups of tools available (Fig. 1.7) 

 
Fig. 1.7 The Groups in the REFERENCES Ribbon 

Click on the tab for the MAILINGS Ribbon and check out the various 
Groups of tools available (Fig. 1.8) 

 
Fig. 1.8 The Groups in the MAILINGS Ribbon 

Click on the tab for the REVIEW Ribbon and check out the various 
Groups of tools available (Fig. 1.9) 

 
Fig. 1.9 The Groups in the REVIEW Ribbon 

Click on the tab for the View Ribbon and check out the various Groups 
of tools available (Fig. 1.10) 

 
Fig. 1.10 The Groups in the VIEW Ribbon 
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The Ruler at the top of the page is an essential tool to have on your screen when you are 
word processing.  It is in the Ruler that you set tab stops and indent markers (which you are 
going to learn about in this tutorial).  If your version of Office Word 2013 does not show the 
ruler at the top of the word processing page (see Fig. 1.11), you need to complete a couple 
of steps before proceeding with the tutorial. 

Fig. 1.11 Setting (showing) the Office 2013 ruler 

Click on the View tab to bring up the View Ribbon (Fig. 1.3 above) 

Now locate the Show Group and click to put a check mark (tick) in the 
box next to Ruler (see Fig. 1.11 above) 

You may also need to set the line spacing to single spaced before you proceed because the 
default setting on the computer you are using may be other than single spaced.  Here’s the 
easiest way to do this. 

Click on the Home Ribbon Tab 

Then in the Styles Group (Fig. 1.12), click on the icon for No Spacing 

Fig. 1.12 The Styles Group No Spacing tool 

Now you’re ready to proceed with the tutorial.  Fig. 1.11 above illustrates the Ruler, along 
with the tool for setting tab stops and the tools for setting indents—called indent markers.  
Most users of Microsoft Word never figure out how to use these tab stops and indent 

Tool for setting 
Tab Stops 

Indent Markers 

The Ruler 
bar 

The Show Group 

No Spacing tool Styles Group 
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markers; many users do not even know they exist!  By the time you are done with these 
tutorials you will be very familiar with them. 

Check out the tool for setting Tab stops; it’s on the same line as the Ruler 
bar at the left edge (Fig. 1.11)—it’s so small you could easily miss it (and 
a lot of Word users do!) 

You’ll be practicing using this Tab Stop tool later in the tutorial, but make a note of it for 
now. 

Make a mental note of the Indent Markers too; they’re on the left and 
right side of the Ruler bar (Fig. 1.11) 

You'll have the opportunity in this lesson to learn how to use each of these essential word 
processing tools. 

Naming and Saving a new Word document 
Look at the new document’s name (it’ll be Document1 or Document2) 
in the top center of the word processor window 

The document is given the default name (Document1 or Document2, etc.) by the system 
because you haven't yet given it a name of your own.  It is ALWAYS a good idea to 
thoughtfully name a new document immediately, before you even enter any data, and save 
it on the drive on which you intend to keep it. 

It is not a bad idea, at the same time, to save a backup copy on another disk drive (though 
you’ll also have the opportunity to create backups at the end of each lesson of these 
tutorials). 
There are two good reasons for naming your files thoughtfully: 

1. You will easily be able to identify the contents of a document if you give it an 
appropriately descriptive name (such as Letter to Mom 3-8-04). 

2. You will more easily find a document at a later date if you are careful to save it in a 
location of your choice—and a thoughtful name will also help you find a document 
you may have misplaced, because you can use the name to have the system search 
for it. 

When you select the Save option, the system will prompt you to identify the location of your 
choice.  So, when it does, be sure to select where you want the document to be saved (on 
which disk drive and in which folder on that drive). 

This is easy enough to do.  Here are the steps in case you don't already know what to 
do. 

Make sure your USB Flash drive is inserted in your computer 

Now from the File menu select Save As 

Word displays the dialog box for the Save As Backstage View (Fig. 1.13 on the next page). 
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Fig. 1.13 The Backstage View Save As dialog box showing the SkyDrive option 

The Save As dialog box prompts you, among other things, 
(1) to select the location or disk drive where you want to save the new document; 

(2) to create or select a folder on that drive in which to save it; 
(3) to type a name for the document. 

The initial Save As Backstage View lists locations where your files can be saved.  Included 
among these is the Microsoft SkyDrive (Fig. 1.13 above).  This is a service offered by 
Microsoft which enables you to save your documents, including photos and folders, on one 
of Microsoft’s servers in what is called The Cloud.  The Cloud is literally a farm of computer 
storage servers located somewhere or other, and it could be anywhere on the planet!  For 
free, Microsoft will give you up to 7 gigabytes (GB) of memory for your files.  If you wanted 
more than that you would have to start paying for the extra space. 

We will not be using the SkyDrive in this book, but it is something of which you should 
be aware.  Feel free to explore this option on your own.  The steps are simple enough, and 
if you are working on your own computer you can go ahead and click on SkyDrive in the 
dialog box and follow the steps laid out by Microsoft to join The Cloud. 

For the exercises that follow, you will use your own flash (USB) drive to save all files 
you will use and create for these tutorials.  Every time you create a new document, you will 
need to navigate to the location where you want to save the files.  Here, then, are the steps 
to save this first document on your flash drive. 

First, put your flash drive in one of the available USB ports in the computer 

The SkyDrive is 
Microsoft’s Cloud server 

where you can save backup 
copies of all your files 
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Now, in the Save As dialog box click on Computer and then click on the 
Browse button (Fig. 1.14) 

 
Fig. 1.14 Navigating to the USB drive 

In the new Save As dialog box (Fig. 1.15), scroll if necessary in the left 
hand frame of the dialog box in order to locate the Removable Disk 
icon—which is your flash drive—then click once on the icon in order to 
open it 

 
Fig. 1.15 Locate the icon for your Removable Disk (your flash drive) 

Now, in the list of folders and files on your flash drive, locate the folder 
named Work Files for Office 2013 and double click on it to open it 

Click on 
Computer and 

then click on the 
Browse button 

Double click on 
Removable Disk to open it 

Scroll up or down using the 
scroll bar till you see the 
Removable Disk icon 
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You should now see a list of four folders, including the Data Files folder you created when 
you prepared it for use with these tutorials (Fig. 1.16 on the next page). 

 
 

 
 

 
 

 
 

 
 

 
 

 
Fig. 1.16 The four folders containing the work files for the Office 2013 tutorials 

Double click to open the Data Files folder 
Creating a new folder on a disk 
Inside the Data Files folder you need to create a new folder to store all the documents you 
will create using Microsoft Word. 

Still in the Save As dialog box, click on the New Folder icon (Fig. 1.17) 
 

 
 

 
 

 
 

 
 

 
Fig. 1.17 The New Folder icon in the Save As dialog box 

Click on the 
New Folder icon 

Double click to open 
the Data Files folder 
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The system immediately creates a New Folder (Fig. 1.18) with a default name highlighted 
in blue, inviting you to rename it by typing a new name of your own. 

 
 

 
 

 
 

 
 

 
 

 
Fig. 1.18 Creating and naming a new folder 

No need to delete the default name, just type Word Documents for the 
new folder’s name, hit the Enter key, then double click on the folder to 
Open it 

Word opens the new, empty folder so that you can save the new document inside it (Fig. 
1.19). 

In the File name: data entry box (Fig. 1.19), type Conference Call Letter 
to replace the default name and press Enter (or click on the Save button) 

 

 

 

 

 

 

 

 

 

 
Fig. 1.19 Naming the Conference Call Letter 

Replace Doc1 with the new 
name Conference Call Letter 
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The Save As option thus allows you to name your documents and at the same time determine 
the location (the folder, on a particular disk) on which you want to store them.  In effect, by 
naming the document and specifying the location on which it will be stored, you are 
reserving a space for the document on the disk.  From now on, you do not need to select 
Save As to save the document unless you want to save a backup or save it in some other 
location.  Whenever you simply Save this particular file, it will be saved with this name 
(Conference Call Letter) in this same folder (Word Processing Files) on your flash drive. 

 
1.3 SOME HELPFUL HINTS WHILE USING WORD 2013 
You will shortly type the text of the Conference Call Letter.  But before you start, take note 
of the helpful hints that follow. 
Word processing is not the same as using a typewriter 
Next to no one uses a typewriter anymore.  But if you happen to be one of those who never 
used a computer but you did used to use a typewriter, read on. 

As you type at the computer keyboard, the letters appear on the screen.  When you use 
a typewriter, however, the letters appear directly on the paper. 

Also, when using a typewriter you have to move the carriage back at the end of every 
line so you can start typing at the beginning of the next line on the page.  This is called a 
carriage return.  When you use a word processor, however, the system takes care of the end 
of each line.  As you type away in word processing, the program is aware that you are getting 
to the end of the line, and it will automatically move a word to the beginning of the next 
line if it doesn't fit completely on the end of a line.  The technical term for this is “wrap 
around.” You don't have to worry about hyphenating words that are broken up over two 
lines—unless you want to, of course. 

So, when you are using a computer, the only time you need to hit the Enter key is at the 
end of a paragraph, whether the paragraph be one word, one line, or several lines. 

Type the following passage so you can practice this now—remember, 
don't press the Enter key until you get to the end of the paragraph, and 
don’t worry if the end of each line on your computer is different than 
shown here2 

And though he tried to look properly severe for his students, Fletcher Seagull suddenly 
saw them all as they really were, just for a moment, and he more than liked, he loved 
what he saw.  No limits, Jonathan? he thought, and he smiled.  His race to learn had 
begun.3 

Now press Enter at the end of the paragraph 
Notice how the word processor took care of the end of each line. 

                                                
2 The lines on your screen may be longer or shorter. 
3 From the book "Jonathan Livingston Seagull: a story" by Richard Bach. New York, NY: Avon, 1970.  And 

yes, the grammar is correct, so don’t worry if it seems odd to you here and there! 
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There are two cursors you need to know about 
When you are word processing, there are two independent cursors you need to know about.  
One is called the I–beam cursor and the other is called the Insertion point cursor (Fig. 1.20 
next page). 

 

Fig. 1.20 The two kinds of cursors 

The I–beam cursor is so called because it looks a bit like an uppercase "I" and not unlike an 
I-beam used in construction.  It becomes an arrow when positioned in the left margin of the 
page or when rolled outside the edges of the page.  Try the following for practice. 

Roll the mouse around and notice how the I–beam cursor follows along 
and changes to an arrow pointing to the left each time you cross the edge 
of the page on either side, or into an arrow pointing to the right if you slide 
over into the left margin of the page 

The Insertion point cursor (which blinks on and off on the screen and is not directly 
controlled by the mouse) is so called because it indicates exactly where characters will 
appear in the text when you type at the keyboard. 

The I–beam cursor, on the other hand, is under the control of the mouse and allows you, 
by clicking on the left mouse button, to position the insertion point cursor anywhere in the 
text of your document.  Practice will help you understand how this works. 

Use the mouse to move the I–beam cursor on the screen so it is 
positioned immediately before the word "Fletcher", then click the left 
mouse button once and roll the mouse away to your right 

The insertion point cursor, which originally was positioned at the end of the Livingston 
Seagull quote, should now be blinking on and off right in front of the word "Fletcher." 
Notice how you used the mouse and the I–beam cursor to change the position of the 
insertion point cursor. 

Now position the I–beam cursor immediately before the word "though" 
in the first line and click the left mouse button so as to position the 
insertion point cursor there 
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Type the word "even" followed by a space, then click at the end of the 
paragraph (after the final period) 

So much for how to move the cursor from one place to another in your document.  This 
takes some getting used to, but the more you practice the more natural it becomes. 

Correcting errors while entering text 
If you see you've made a mistake and you want to fix it before you go on, you can use either 
the Backspace key or the Del(ete) key (Fig 1.21). 

 
Fig. 1.21 The difference between the Backspace and Del(ete) keys 

The Backspace key removes text that is left of the cursor, while the Del(ete) key removes 
text that is to the right of the cursor.  Try the following example using the Backspace key. 

Use the mouse to put the insertion point cursor immediately after the 
word “even” 

Press the Backspace key as many times as necessary to remove the 
word “even” then click at the end of the paragraph to position the cursor 
there 

You can use the Del(ete) key for this purpose, too.  To use this key you would position the 
cursor immediately before (to the left of) the character(s) you want to delete.  So the 
Backspace key works backwards and the Del(ete) key works forwards (see Fig. 1.21 above). 

After you’ve deleted the text, you would use the mouse to click at the point in the 
document where you want to resume typing.  Try the following example. 

Position the cursor right before the word "though" in the first line 

Press the Del key till the word "though" and the following space have 
been deleted 

You get the idea? Now hit ctrl-z as many times as necessary to restore 
the word “though” and the following space 

Removing unwanted Returns (using the Show ¶ option) 
You can have Word show you exactly where, in your document, you hit the Enter key (say, 
at the end of paragraphs).  The easiest way to do this is to click on the Show ¶ icon in the 
Paragraph Group of the Home Ribbon (Fig. 1.22). 
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Fig. 1.22 The Show ¶ icon on the Standard toolbar 

Click on the Show ¶ tool now 
The ¶ symbol is the standard mark used by editors to indicate the need for a paragraph break 
in running text.  In the Conference Call Letter that you’ll be typing shortly, the ¶ symbol, if 
you have the option turned on, would appear where you hit Enter at the end of each 
paragraph.  Another ¶ symbol would appear on an empty line because, strictly speaking, the 
empty line is another paragraph break. 

The Show ¶ tool also puts a dot to show wherever there is a space in the running text.  
This is useful for you to see if, for example, you have typed extra spaces here and there that 
you may want to remove.  I’m not sure how useful this particular aspect of the Show ¶ tool 
is, but at least you now know what those dots everywhere are. 

Position the cursor immediately before the sentence that begins “No 
limits, Jonathan?…”, then hit the Enter key twice 

Notice the ¶ symbols that show you where you hit the Enter key—one at the end of the 
previous line, and the other on the empty line ahead of the cursor. 

Now remove the Paragraph marks you just entered by pressing the 
Backspace key twice 
Finally, click on the Show ¶ icon in the Paragraph Group of the Home 
Ribbon to turn off the paragraph marks and all the dots between the 
words 

Undoing unintended actions 
If you do something you didn't intend to do, or you made a mistake, you'll select Undo from 
the Quick Access toolbar which is located right above the File menu in the top left corner 
of the Word window (Fig. 1.23).  This is a lifesaver that you will use often! 
 

 
Fig. 1.23 Undo/Redo tools 

Show ¶ 

Undo/Redo 
tools 

Quick Access 
toolbar 



ESSENTIAL MICROSOFT OFFICE 2013: Tutorials for Teachers 
Copyright © Bernard John Poole, 2013. All rights reserved. 

 

 20

Check out this Undo option in the Quick Access toolbar now so you 
can see where to find it 

A quicker way to Undo is to use the shortcut Ctrl+Z on your keyboard.  You also can undo 
any number of specific recent actions by clicking on the arrow next to the Undo tool in the 
Quick Access toolbar (Fig. 1.23 above), which will drop down a menu or list of the various 
actions you have taken since the last Undo.  Be careful when you use this feature, however, 
because if you undo, say, 10 actions, all the actions you did prior to that will also be undone! 

Scrolling through a document 
We need to open a longer document so you can practice different ways of scrolling. 

From the File menu select Open, locate the Work Files for Office 2013 
folder and open it, then open the Work Files folder, then in the Practice 
folder, open the document called Term Paper 

Now, with the Term Paper document open on the screen, take a look at the scroll bars.  On 
the right of the screen you have a vertical scroll bar and, inside it, the vertical scroll box.  
At the bottom of the screen you have a horizontal scroll bar and horizontal scroll box (Fig. 
1.24). 

 
Fig. 1.24 The scroll boxes 

Vertical 
scroll box 

Horizontal scroll 
box 
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At either end of the scroll bars are arrows pointing in opposite directions (left and right, or 
up and down).  As you might expect, clicking on these arrows will scroll a document left or 
right or up and down.  Scrolling from left to right or right to left is simpler than scrolling up 
or down, since you only have the width of the page to deal with.  But the process is the same 
for scrolling up and down, too. 

Try scrolling now from side to side—left to right and back again—by 
clicking on the scroll arrows to move the scroll box in the horizontal 
scroll bar 
Try scrolling now up and down by clicking on the scroll arrows to move 
the scroll box in the vertical scroll bar 

You can scroll a lot faster by positioning the mouse arrow on the scroll box itself, holding 
down the left mouse button, and dragging the box left or right, up or down, in the scroll 
bars. 

Try this, too 
If you click either side of the scroll box inside the horizontal or vertical scroll bars, this 
causes the document to scroll in jumps from side to side or up and down. 

Try this as well 
You also can scroll and position the cursor very precisely across a line of text, character by 
character, or up and down from line to line, by using the arrow keys on the lower right of 
the keyboard. 

Try this as well 
Finally, yet another vertical scrolling option is available if you have a mouse with a 
rubberized wheel between the buttons, as illustrated in Fig. 1.25. 

 
Fig. 1.25 The scrolling wheel on the mouse 

Try this, too 
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When you have finished experimenting with the scroll bars, close (File > 
Close) the Term Paper document 

Shortcuts or quick keyboard commands 
The quickest way to save your work is to press Ctrl+S on the keyboard.  The Ctrl (Control) 
key is in the lower left corner of the keyboard.  Locate it now.  You'll be using it a lot as 
you become more familiar with the Office programs.  It is always used in combination with 
one or two other keys.  Ctrl+S, for example, is executed by holding down the Ctrl key and, 
while holding the Ctrl key down, simultaneously pressing the S key. 

You'll learn more shortcuts as you work your way through the tutorials.  The author has 
prepared a chart that breaks down the most used Office Word 2013 quick keyboard 
commands.  You will find this chart handy when you are learning to use the software for 
the first time.  The chart is available as a separate download at the end of the list of contents 
on the download site for these Office 2013 tutorials 
(http://www.pitt.edu/~edindex/Office2013frame.html).  For ready reference, print out the 
Quick Keyboards Commands sheet which lists the most frequently used Office 2013 
shortcut keyboard commands. 

Renaming a document 
You will sometimes want to rename a document that you've already saved on your disk.  
One way you can do this from the desktop is by right-clicking on the icon for the document 
you want to rename.  Then, from the context menu that pops up whenever you right-click 
on an object on the screen, select the option to Rename…, which highlights the document’s 
name so that you can type a new name for it. 

To rename a document which you already have open in Word, or in any other Office 
2013 application, you would choose Save As from the File menu.  This will give you the 
opportunity to save the document with a new name of your choice.  Bear in mind, though, 
that when you do this, the document with the original name will still be on your disk—a 
second copy, if you like.  If you don't want to keep this copy, you should delete it right away 
so as to remove unwanted clutter from your disk drives. 
 
1.4 CREATING AND SAVING A DOCUMENT 
Practice makes perfect 
You still should have open the Conference Call Letter, with the Jonathan Livingstone 
Seagull quote.  You need to clear the Seagull quote from the document, so here are the steps 
to remove it. 

In the Home Ribbon > Editing Group choose Select All from the Select 
menu then press the Backspace key once to remove the highlighted text 
from the document 

You can also Select All using the Quick Keyboard command ctrl-A, or you can use the 
mouse (or your finger if you have a touch screen) to drag to highlight the whole paragraph, 
or you can triple click on the paragraph. 

Notice that the Backspace key removes all highlighted text.  The Del(ete) key does the 
same. 
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Typing the Conference Call letter 
You should now have a blank page with the cursor waiting in the top left corner, ready for 
you to type in the Conference Call Letter.  Fig. 1.26 below has the full text of the Conference 
Call letter.  The Figure also shows where all the Paragraph marks (¶) are.  This will help 
you remember to hit the Enter key only where necessary, not at the end of every line. 

As you type, Word will automatically warn you of any spelling or grammar errors it 
finds (by underlining them in red or blue on your screen).  This will occur as you type the 
contents of Fig. 1.26.  Don’t worry about these warnings for now. 

A momentary loss of power is enough for you to lose all your work, so be sure to get 
into the habit of saving frequently with the quick keyboard command Ctrl-S as you go 
along.  It takes a second to lose your work; and it only takes a second to hit Ctrl-S at the 
end of every paragraph or whenever you switch to another task while at the computer, or if 
you leave the keyboard to do something else. 

First, type your name at the top of the letter immediately above the 
line that reads “Hodge Road Elementary School” 

 

Fig. 1.26 First version of the Conference Call Letter 
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Now go ahead now and type in the text of the Conference Call Letter 
from Fig. 1.26, saving every few lines as you go along (from the File 
menu select Save—or press Ctrl-S) 

Once you have typed in the whole document and saved it, you should go back and correct 
any errors you may have made, and then save the document again.  Remember: when you 
save a document with the same name as before, you are replacing the earlier version.  You 
won't be creating a second copy. 

 

1.5 UPDATING AND SIMPLE FORMATTING OF A DOCUMENT 
Now that your letter is saved on disk, you can make any revisions you want. 

Word processing allows you to treat text like modeling clay.  You can easily mold your 
words and ideas.  You can change margins, put in underlines, italics, boldface, and so forth.  
You can correct errors, move text around, lay it out on the page—all at the touch of a few 
buttons.  In the next lesson (Lesson Two) you will have an opportunity to become quite 
sophisticated in this regard.  But let's keep it simple for now.  Refer back to Fig. 1.26 while 
you complete the next few sections of the tutorial. 

Inserting the date 
There is no date on the Conference Call Letter in Fig. 1.26.  A letter is incomplete without 
a date, so here are the steps to have Word put today's date in the letter. 

Use the I–beam cursor to position the insertion point cursor right after 
the zip code in the first address at the top of the page, then press Enter 

The cursor should now be waiting at the beginning of the next line. 

In the Insert Ribbon, Text Group, click on the Date & Time tool (Fig. 
1.27) 

  

Fig. 1.27 Date and Time tool 

This brings up the Date and Time dialog box (Fig. 1.28 on the next page).  As you can see, 
it offers a list of formats for the date and the time of day. 

Text Group 

Date & Time 
tool 
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Fig. 1.28 Date and Time dialog box 

Click on the Date format you like best, then click to put a check 
mark/tick in the box next to Update Automatically (Fig. 1.28) and click 
on OK 

You will appreciate the advantage of allowing Word to insert the date for you (by updating 
automatically) when you save the letter as a template. Later, any time you use the template, 
or print another Conference Call letter, the date will be adjusted automatically to reflect the 
current date on which you edit or reprint the document. 

Adding text to an existing document  
You will most always want to add text to an existing document—make revisions and so 
forth; it is an activity which is fundamental to the whole process of writing.  On a typewriter, 
making any kind of change to a document is usually messy, and often difficult to do.  When 
you use the word processor, however, it is a simple task.  Let's practice now. 

There is no limit to the extra details that could be added to the letter, but for the sake of 
this exercise you will add just one sentence to the next to last paragraph to help the parents 
appreciate what Hellen will get out of his experience at the Institute. 

Position the insertion point cursor so it is right at the end of the 
paragraph (the paragraph, not the sentence) which begins "The 
institute has a wonderful reputation..." 

Press the space bar and type the sentence: 

He would thus have the opportunity to meet and make friends 
with others of his own age and academic ability. 

Read over the sentence you just typed to check for errors.  Correct any you may have made.  
Before you go on to the next section you should save what you have done so far. 

Press Ctrl+S to save the changes you have made to the letter 
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Removing text 
There are several ways of removing text.  In a moment you'll learn how to highlight a block 
of text in order to move or delete larger sections of text.  But if all you want to do is remove 
a few words, or a short sentence, the quickest way is to use the Backspace key. 

Practice this now.  You are going to remove the second sentence of the second 
paragraph.  This second sentence begins "I have attended the facility myself...". 

Position the insertion point cursor so it is in front of the "T" at the 
beginning of the third sentence of the second paragraph—the sentence 
that begins "Hellen would take part ..." 
Press the Backspace key as many times as is necessary until the 
second sentence of this paragraph is removed from the letter 

You'll find the automatic repeat feature of the keyboard (activated by holding down a key 
such as the Backspace key) will come in handy for a delete operation like this. 

Press Ctrl+S again to save the changes you just made 

Changing text 
It is often necessary to change a word or words here and there in a document.  The 
Conference Call Letter overuses the word "program," for example.  The word appears once 
in the first paragraph and then is used twice in the final paragraphs.  To improve the letter 
it would be better to rewrite the first sentence of the next to last paragraph to read: "The 
Institute has a wonderful reputation for its offerings for both children and adults." 

Here are the steps to follow to carry out this change. 

Place the cursor between the period (full stop) and the "s” at the end of 
the first sentence in the second paragraph (right at the end of the word 
"programs" but before the period (full stop)) 

Use the Backspace key to remove the text “both children and adult 
programs” 

Make sure there is still a space after the word “for”, then type the phrase 
“its offerings for both children and adults.” 

Another change you need to make is to the telephone number in the first sentence of the last 
paragraph.  A common error with numbers is called transposition, where one accidentally 
reverses the order of digits.  The number is supposed to be 772–3232, not 3223. 

Position the cursor just at the end of the telephone number 

Press the Backspace key 2 times, then type the digits "32", and once 
again press Ctrl+S 

At this stage your Conference Call Letter should look much the same as Fig. 1.30 on the 
next page. 
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Fig. 1.30 Intermediate update to the Conference Call letter 

Selecting (highlighting) a block of text 

Highlighted text is text that stands out from the rest of the document because, in the case of 
Office 2013, the background of the highlighted text becomes a block of light blue color (Fig. 
1.29). 

 

Fig. 1.29 Highlighted text 

When you highlight text, you can do things to it (delete it, move it, copy it, change the 
margins set for it, change the font, the text style or color, and so on) without affecting the 
rest of your document. 
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You can highlight a single character... 

Use the mouse to position the cursor so it is immediately before the "H" 
in “Hodge" in the address at the top of the letter 

Hold down the left mouse button and keep it down as you carefully drag 
across just the "H" at the beginning of the word so that it becomes 
highlighted 

This latter operation is tricky the first few times you try it.  If you drag across more than just 
the "H", keep your finger on the left mouse button and drag back until you have just what 
you want highlighted. 

You can select as much or as little of the text as you want.  Remember, you're in control.4 

Let go of the left mouse button when just the "H" is highlighted 

Now click anywhere in the text to remove the highlighting (i.e. to deselect 
the selected text) 

Try this a few times on different letters anywhere in the document 

You can highlight a single word... 

Position the I–beam cursor anywhere over the word "Elementary" in the 
first line of the address at the top of the letter and double click the 
left mouse button (or you can drag across the word using the mouse) 

The single word "Elementary" should be highlighted on the screen. 

Click anywhere in the text to remove the highlight 

Try this on a few more words anywhere in the document till you're 
comfortable with the action 

You can highlight a line of text... 

Position the cursor in the margin to the left of the first line of the 
address at the top of the letter (the cursor changes from an I-beam to 
a white arrow pointing in at the line at the edge of the text) and click on 
the left mouse button  

                                                
4 If you are new to word processing, the secret here is: don't panic! No matter how much you might think to 
the contrary, when you're working with computers you are in control—as long as you know what you're 
doing. The computer is just a dumb machine designed to serve your information processing needs. These 
tutorials will help you make this dumb machine your friend. 
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There you have it! The whole line is highlighted. 

Click anywhere in the text to remove the highlight 

Try this on a couple of different lines in the document 

You can highlight several selected lines... 

Move the cursor into the margin immediately in front of the first word of 
the first paragraph (the cursor becomes a white arrow pointing in at the 
line) 

Hold down the left mouse button and drag down to select (highlight) a 
couple of lines, then let go of the left mouse button 

Click anywhere in the text to remove the highlight 

You can quickly highlight an entire paragraph... 

Move the I–beam cursor anywhere in the first paragraph, triple click 
(quickly click 3 times) on the left mouse button and notice how this 
highlights the entire paragraph 

Click anywhere in the text to remove the highlighting 

You can highlight an extended area (or block) of text... 

Place the cursor right at the start of the second paragraph 

Now, while you hold down the Shift key, click at the end of the paragraph 
and notice that the whole paragraph is highlighted 

Click anywhere in the text to remove the highlighting 

You can quickly highlight an entire document... 

You should be getting the hang of this highlighting by now.  You can drag the mouse to 
highlight several paragraphs or even an entire document of several pages.  However, 
dragging through a 50 page document would quickly become tedious.  So Word provides a 
short cut to select an entire document.  You may recall using this feature earlier in the 
tutorial. 

Press Ctrl+A (or, in the Home Ribbon > Editing Group choose Select 
All) 

Click anywhere in the text to remove the highlighting 
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Changing margins and using the Word Indent Markers 
The letter is nearly ready to be printed.  There are just a couple more changes you need to 
make.  One style for letter–writing is to indent every paragraph ½”, for example.  Another 
is to position the first address (the address of the sender) so it appears at the top right of the 
first page, instead of on the left.  In this case, the closing signature could also be aligned on 
the right side of the page at the end of the letter (Fig. 1.31). 

 

 
Fig. 1.31 The final version of the Conference Call Letter 

To carry out these changes you need to learn how to use the indent markers. 
Using the Indent Markers 
Indent Markers are used to adjust the first line and the left and right margins of paragraphs 
(not individual lines, unless a paragraph only has one line).  To use the indent markers you 
need to have the ruler showing at the top of your document. 



Lesson 1: Introduction to Word 2013  

 

 31

If you do not see the Ruler Bar at the top of the document (see Fig. 1.33 
below), then in the View Ribbon Show Group click to put a check mark 
or tick next to the Ruler option 

Now, click to put the cursor anywhere within the first paragraph of the 
letter (this tells Word which piece or paragraph of text to reformat) 

Before we go on, remember that the tip of the mouse pointer is the hot spot 
(Fig. 1.32).  Moving the small indent markers is a delicate operation; be sure 
to position the very tip of the mouse pointer on an indent marker. 

 

 

 

 

Fig. 1.32 The tip of the mouse pointer is the Hot Spot 

On the left side of the ruler, at the 0" hash mark, you can see the three indent markers that 
set the Hanging Indent, the Left Indent and the First Line Indent (Fig. 1.33). 

 

Fig. 1.33 The Indent Markers 

These markers move together when you drag the Left Indent marker (the small rectangular 
marker on which the other two triangular markers sit). 

Let’s practice doing this. 

Place the tip of the mouse pointer on the Left Indent marker (see Fig. 
1.33) on which the Hanging Indent marker (the lower of the two 
triangular markers) sits 

Use the mouse to drag the Left Indent marker across ½” to the right 
(to the ½” hash mark on the ruler)  

The tip of the 
mouse pointer is the 

Hot Spot 
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Notice that the First Line Indent marker (the upper triangular marker) and the Hanging 
Indent marker (the lower triangular marker) shifted right along with the Left Indent marker 
and that the whole paragraph moved to the right half an inch (½”). 

Position the tip of the mouse pointer on the First Line Indent marker 
(the top triangular marker) and independently slide it to the left or right 
(you won't be able to drag further left than the left edge of the page) 

To independently move the Hanging Indent marker (the lower of the two triangular markers) 
you just point at it and drag it to the left or right in the same way (again you won't be able 
to drag further left than the left edge of the page). 

Try this now 

The following directions will give you more practice using these indent markers.  You will 
be setting the indent markers for all the paragraphs in the body of the letter. 

First, make sure you can see the whole letter in the window (maximize 
the window if necessary), then click before the first word of the first 
paragraph to position the insertion point cursor there 

Now, while holding down the Shift key, click at the end of the third (last) 
paragraph (after the words “…from you soon.”) 

All three paragraphs of the letter should now be highlighted. 

First, if necessary, drag all the indent markers so they are at the left 
edge of the page (back at the 0” hash mark) 

Now position the tip of the mouse arrow on the First Line Indent 
marker (the triangular indent marker on top of the others) and slide it 
to the right to the ½” hash mark on the ruler 

Notice that the left margin of each paragraph (except for the first line) is now set at 0 inches 
and the first line of each paragraph is set at ½". 

Practice makes perfect 
If this is the first time you've used these markers you may still feel uncomfortable working 
with them, if only because they’re rather small and may be difficult for you to grab with the 
mouse pointer.  More practice will cure that. 

Next you are going to move over the left margin for the First Address and the Date at 
the top of the letter, and then the left margin for the sign off at the end of the letter.  Follow 
these steps. 

Drag to select (highlight) the First Address and Date lines at the top of 
the letter (the first four lines) 
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Point at the Left Indent marker (the small rectangular marker at the 
bottom of the indent markers), hold down the left mouse button and drag 
all the indent markers together over to the 3" hash mark on the ruler 

Let go of the mouse button, then click anywhere in the text to de-select 
the highlighted text 

The address and date should now be lined up on the new 3" margin.  If you weren't 
successful the first time, just go through the steps again until you get the hang of it. 

Next scroll down to the end of the letter if it doesn't show on the screen 

Select the lines that begin: "Sincerely yours," and that conclude with 
"Ms. Mary Prendergast" and “Department Chair” (including all the 
blank lines in between) 

With these lines highlighted, again move all the indent markers across 
to the 3" hash mark on the ruler, as you did for the address at the top of 
the page, then press Ctrl+S to save this (almost final) version of the 
document 

 

1.6 CHECKING THE DOCUMENT FOR SPELLING ERRORS 
Microsoft Office 2013 comes with a spelling checker.  No matter how good you might think 
your spelling is you would do well to take advantage of this fast, effective tool for catching 
spelling errors or typos. 

Encourage your students to use a spelling checker when they are proofing their word 
processed work.  The system will highlight any words that it cannot find in its dictionary 
and may make suggestions for words or spellings the student intended.  It can thus help your 
students become better spellers, and broaden their vocabulary if they are curious enough to 
check out the meanings of the words they may never have come across before. 

However, it cannot spell for them—yet! Nor can it correct errors such as the misuse of 
"to", "too", and "two"! A spelling checker is not an alternative to proofreading.  Tell your 
students they should always proofread their work on the printed page (in hard copy form) 
after they have run it through the spelling checker.  It also would be a good idea to have 
another student proofread papers for them.  Assessing a classmate’s work is a valuable 
collaborative learning experience. 

Accessing the spelling checker 

In the Review Ribbon, Proofing Group select Spelling & Grammar 

This will bring up the dialog box shown in Fig. 1.34 on the next page. 
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Fig. 1.34 Spelling and Grammar dialog box 

The Word spelling and grammar checkers are probably already working for you if those 
functions are in automatic mode, if you see strange looking underlines under some of the 
words you typed.  If Word highlights a word or phrase, this does not necessarily mean there 
is anything wrong with it.  You still have to be able to tell if you have made an error and 
also know how to correct it.  Remember, the computer is just a dumb machine—it is a tool 
to assist your intelligence, not replace it! 

If you tell the Spelling Checker to check your document, and it has "No suggestions" 
for a word highlighted, the dialog box gives you the option to have the Spelling Checker 
Ignore (because the word is correct as is); or Ignore All occurrences of the same word in 
your document (because you don’t want the Checker to stop for them again); or Add the 
word to the custom dictionary (so it won’t be flagged in future documents you work on).  
This is generally useful for proper names. 

In the example in Fig. 1.34, the word “Elementary” has been mistyped and, as you can 
see, the misspelling was picked up the spelling checker and drawn to your attention.  To fix 
the problem, you just click on the Change button, and Word 2013 will fix it on the spot. 
At one time or another you will find all these features useful, so you should take the time to 
check them out.  For the most part the Spelling Checker is intuitive, and one of the best 
things you can do at this time is take a few minutes to browse through the various selections 
until you get a feel for what the Spelling Checker can do. 
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Using the Spelling and Grammar... option in the Tools menu, work your 
way through the Conference Call Letter and correct any spelling or typing 
errors you may have made 
Save your work one last time when you are done (press Ctrl+S) 

In Lesson 2 you will make more extensive use of the Word Spelling Checker. 

 
1.7 PRINTING A FIRST DRAFT OF THE DOCUMENT 
Print Preview–ing your work 
It is always useful to preview your work on screen before sending it to the printer.  In Office 
2013, you will always be able to preview your work in the Print dialog box before you send 
it to the printer.  Let’s see how this works. 

From the File menu select Print (or press Ctrl+P) 
Word will present you with the Print dialog box which will be similar to that shown in Fig. 
1.35 (though every computer has minor variations when it comes to printing). 

  

Fig. 1.35 Typical Office Word 2013 Print dialog box 

What kind of printer are you using? 
If you have a laser printer, the quality is always "Best." But if you have a dot matrix, daisy 
wheel, or inkjet printer you can choose the quality of output you require.  You select the 
print quality by clicking on the Properties button in the Print dialog box. 
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Printing a range of pages 
With regard to Page Range, the Print All Pages option is selected by default.  The 
Conference Call Letter is only one page long, so you will by default want to print the entire 
document.  Should you want to print a subset of the pages of a long document, say from 
page 3 to page 6, you would click the Print All Pages option (see Fig. 1.35 above) and enter 
the page numbers of the range of pages in the data entry box (ex. 1,3,5-12). 

Setting the number of copies 
Word also asks you how many copies you want to print.  As you can see (Fig. 1.35), the 
number 1 is already selected by default, and for a draft copy that is certainly as many as you 
would normally want. 

You are now ready to print the document. 
Click on OK in the Print dialog box 

If all is well with your printer connections and so forth, your printer will now go ahead and 
produce a hard copy of your document. 

Removing your document from the printer 
If you are using a laser printer or an ink jet printer, removing the paper from the printer is 
simply a matter of picking it out of the paper tray. 

In the unlikely event that you are using a dot matrix printer with continuous form paper 
(now rarely seen in computing environments) here are the steps to follow. 

Hit the Select button on the printer (the green light will go off) 
Press the Form Feed button (the paper will advance to the top of the 
next page) 
Press the Select button again (the green light will go back on) 
Carefully remove your document by tearing along the serrated edge 

First time users of dot matrix printers will find it tricky removing the printed document from 
the printer.  Don't be surprised if you damage the page as you learn to get used to tearing 
along the serrated edge.  This is another good reason to start by producing draft copies of 
your documents. 

Save the environment 
A useful environmental tip, for your draft copies, is to reuse paper that has one side 
blank.  Keep a box near the printer where others who use the printer can deposit used 
paper that is clean on one side.  Only use new paper for a final copy of a document. 

Always proofread your writing 
Now you should take the time once again to carefully read over what you have typed. 
If you used the Spell Checker, remember that it will not necessarily pick up all errors.  If 
you type "me" when you meant to type "he," the checker won't mind in the least, since both 
words are in the dictionary.  As we noted earlier, the golden rule here is: A Spelling Checker 
is only as good as you are! You should never rely blindly on the feedback from the Spelling 
Checker.  So always proofread your writing—and tell your students to do the same.  You 
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might also have your students proofread each other's papers.  Let them be teachers, too; it's 
a great way to learn! 

You should also check the overall page layout to see that the document looks good on 
the page.  If there are problems, now is the time to fix them.  Make all necessary changes 
on the computer and save the document again on your disk drive. 

If all is well, you are ready to go ahead and print the final version, the one that you will 
send in the mail to the parents.  Later, in Lesson 6, you will have the opportunity to learn 
how to use Mail Merge to send individualized copies of a letter to a large number of 
addresses. 

 
1.8 RUNNING OFF A FINAL COPY 
Follow the steps you learned above to run off a final copy of your document. 

Most printers today will accept single sheets of paper.  So if you wanted to use your 
school's letterhead, this would be no problem.  You would, of course, need to remove the 
sender's address from the top of your Conference Call Letter since this address would 
already be included on the letterhead paper.  You might also need to select manual feed for 
the printer, depending on the type of printer you are using. 
 

1.9 MAKING A BACKUP COPY OF THE DOCUMENT 
Your last task before completing this session at the computer should be to make a backup 
of your document.  Earlier in this lesson you were asked to prepare a backup disk for all 
your work.  Now is the time to learn how to make a backup copy of a single document.  For 
the sake of convenience, you’ll make the backup in the same folder (the Data Files folder) 
as the rest of the data files you will create using these tutorials. 

The Conference Call Letter is still open in Word 2013.  It is also saved in your Work 
Files for Office 2013 folder, since that is where you have been saving it all along. 

From the File menu select Save As and in the Save As dialog box make 
sure the Data Files folder is open, then change the file name to 
Conference Call Letter Backup and click on the Save button 
Wait while the file is being saved, then close Word (File > Close) 

 
LOOKING BACK 
In this tutorial you have learned the basics of the Microsoft Office 2013 Word word 
processor.  You now know how to enter text, save it, revise it, set margins, check it for 
spelling, and print it on paper in draft, standard, or letter quality.  You also learned one way 
to make a backup copy of your documents. 

Many computer users learn no more than has been covered in this lesson.  Under–
utilization is a common fact of life for most computer users; they never discover the wide 
range of useful things the computer can help them do.  Ideally, however, this tutorial should 
have made you keen to learn more about Word.  Remember what you learned in Lesson 1.  
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You may need to refer back to some of the details spelled out here when you are using the 
word processor on your own. 

Above all, keep an open mind.  It is almost impossible to know everything about the 
computer, so there is always a lot to learn, even when you think you know it all! 

 

LOOKING FORWARD 
This has been a good introduction to the Microsoft Office 2013 word processor.  However, 
there is still a great deal to learn.  Lesson 2 will give you an opportunity to further advance 
your skills. 
Many of the word processing skills that you have learned will transfer across to other word 
processors.  The more you use the computer as a tool for writing, the more natural it will 
become and the more you will improve your writing ability.  The ease with which you can 
make changes will have a significant impact on your willingness to generate quality written 
communication.  Needless to say, word processing will have the same effect on your 
students, so the sooner you can get them using the computer for all their writing assignments 
the better. 

 

SKILL CONSOLIDATION 
Complete these exercises to reinforce what you have learned in Lesson 1.  This will help 
you appreciate the usefulness of the word processor for all your writing tasks. 

1. Use Word to write a letter to someone in your family or to a friend using the same layout 
as the Conference Call letter.  There must be at least four paragraphs in the body of the 
letter.  Print out a draft copy of the story, proof read it, correct any errors, then print out 
a final copy of the story.  Hand in both copies to your instructor. 

2. Write a letter to a school district superintendent explaining the details of a field trip that 
you are planning for your class.  Print out a draft copy of the story, proof read it, correct 
any errors, then print out a final copy of the story.  Hand in both copies to your instructor. 

3. Write a short story of at least four paragraphs using Word.  Set the right and left margins 
at 1.5 inches.  Print out a draft copy of the story, proof read it, correct any errors, then 
print out a final copy of the story.  Hand in both copies to your instructor. 

4. Use Word to type up a paper of your choice.  Print out a draft copy of the paper, proof 
read it, correct any errors, and then print out a final copy of the paper.  Hand in both 
copies to your instructor. 

5. Using Word, type a paper of at least four paragraphs explaining what you have learned 
so far in tutorial 1.  Print out a draft copy of the paper, proof read it, correct any errors, 
and then print out a final copy of the paper.  Hand in both copies to your instructor. 

6. Open Word to create a new document.  Name the document “A Day at the Beach” and 
type at least four paragraphs on this topic.  Practice adding and deleting words, phrases, 
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and whole sentences.  Print out a draft copy of the paper, proof read it, correct any errors, 
and then print out a final copy of the paper.  Hand in both copies to your instructor. 

7. Open the document "Conference Call Letter." Change the date so that it is the current 
date, save the updated document.  Remove all the first line indents from the paragraphs.  
Add a paragraph explaining that if Hellen cannot attend the Institute this year, the offer 
will be open again next year.  Save the updated document.  Print out a draft copy of the 
letter, proof read it, correct any errors, then print out a final copy of the letter.  Hand in 
both copies to your instructor. 


